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================================================== 

Note:  MapleSoft DayCare is our first version that is compatible with Windows Vista and 

Windows 7 64bit versions.  It is also still compatible with Windows 2000, XP, Vista 32bit & 

Windows 7 32bit versions.  This latest version does not have all of the features that DayCare 

2008 2nd Edition and older versions had.  Our manual may reference some of those older 

features that are no longer available.  MapleSoft DayCare no longer has a staff time clock or 

payroll that is integrated within the program.  There is no built in importing of timeclocks 

within the program.   The child attendance integrated feature is still part of MapleSoft 

DayCare.  You can also import your data from DayCare 2000, DayCare 2005 or DayCare 

We hope you'll find this simplified version easier to use.  There are some new features such 

as 3 checkbooks and a Simple General Ledger plus better profit and loss statements. 

1) Getting Started 

2) Setting Up Master Records 

3) Using Attendance & Activity Records  

4) Using Child Accounts "Billing" 

5) Scheduling Attendance and Accounts 

6) Using the Checkbook 

7) Paying Bills 

8) Menu Planner 

9) Shots & Immunizations 

10) Waiting List 

11) Reports 

12) Options & Tools 

13) Other Information 

Note:  That there is a Daycare manual in PDF format that includes pictures and more 

details that was installed to the MapleSoft menu.  You can also download this manual from 

www.maplesoft.net from the download page. 
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GETTING STARTED 

================================================== 

QUICK START NOTES: 

================================================== 

1) Install the program "d:\insopt" 

2) Enter Company Information 

Note: Also check "More Settings" 

3) Setup Master records. 

A) Programs 

B) Charges 

C) Pay Types 

D) Staff Master Records 

E) Child Master Records 

1) Enter Child ID & Information 

2) Assign Program & Charge Id to Child 

F) Chart of Accounts 

4) Setup Attendance Schedule 

5) Optionally Setup Account Schedule 

"Unless using Account Generator - see below" 

6) Enterring Data & Getting Around 

A) Use "Add New Record" - "Green + button". 

B) Use "Record Navigation" buttons - "Top left 6 buttons". 

C) Use "Selection Pulldown List" - "To insert ID". 

D) Use "View Filters" - "Top Right for viewing selected data". 

E) Hold mouse over buttons & fields for "Speed Tips". 

7) Read Through this Manual "So that things are setup properly". 

================================================== 

DETAILED INFORMATION 

================================================== 

A) Installation 

1) Insert your CD into the computer.  Or download the installation file and save it to your 

computer.  Then Run or start the installation from your computer. 

2) Click on the "Start" button. 

3) Choose "Run". 

4) Type in: 

A) D:\DAYCARE32.EXE 

B) D:\INSOPT - if you are using the CD - note that "D:" should be the letter of your CD 
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-ROM drive. 

5) Accept the default paths, by clicking on "Continue". 

Note that if you are installing to a network, you may need to change the drive letter to a 

mapped network drive.   

6) Next click on the "Install" Button 

B) How Things Work 

1) How to start the program. 

2) Entering your registration number. 

3) Setting up company information. 

4) Common buttons & menus 

5) Setting up Master records 

6) Understanding how things work 

1) To start MapleSoft DayCare or DayCare 2000/2005/2008/2005/2008 - Click on the 

"Start" button, choose "Programs", choose the "MapleSoft" menu, choose the "DayCare 

2000/2005/2008" menu item. 

2) To enter your Registration number - Click on the "Help" menu, choose "Register", Enter 

Registration number, Click on the "OK" button.  Do this after you have purchased the 

Also note that you will be asked if you wish to remove the sample data.  If you have already 

started setting up your own data, you will want to answer "No", so that your data is left.  If 

you wish to start from scratch "with no records", you can answer "yes". 

3) You will need to enter your Company Information, so that reports will include your 

company name.  To enter Company Information - click on the "File" menu, choose "Open", 

choose "Company Setup".  You have the following fields to enter.  

A) Company Name 

B) Address, City, State & Zip 

C) Phone 

D) Fax Number 

E) E-Mail & Web 

F) Day Starts with A or P for Am or Pm 

J) Day Ends with A or P for Am or Pm 

K) Military Time - Check this box if you want to enter time in Military Time. 

We recommend reading the "About Time" in "Other Information".  Also we recommend that 

you do not use military time. 

It is important to at least enter your Company Name & the "Day Starts" &"Day Ends" fields.  

These time fields will help auto insert attendance fields later on when, you are entering 

Child Attendance.  Your company name will show on reports and on the main program 

To accept & save your company information, click on the "File" menu & choose "Close".  
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Also before closing company information, you may wish to go into "More Settings".  Here 

you can setup passwords. 

4) Common buttons & menus. 

Most of the data forms have similar navigation & data management buttons. 

From Left to Right - these buttons include 

A) The first button will take you to the top or first record, when viewing data. 

B) The second button will move up one record 

C) OR rightmouse click to page up 20 records. 

D) The third button will move your cursor down one record. 

E) OR rightmouse click to page down 20 records. 

F) The fourth button will take you to the bottom or last record. 

G) The button with the magnifying glass is a search button, that will popup a search form. 

H) The button with the printer is a print report Button & is unique to each form.  Note:  

"Most reports can be found in the (Report) menu". 

I) The button with a plus sign is used to add a new record.   

J) The button with the minus sign is used to delete the currently selected record. 

Note that if you are in a table view "spreadsheet style", then you can do a "Ctrl & U" to also 

delete the currently selected record "quickly". 

K) The radio style buttons are for sorting & will display speedtips for which field they will 

sort on. 

You do not have to remember what each button does, because when you place your cursor 

the button, a speedtip will appear telling you what that button does. 

All data forms have common "Windows" style menus.  Such as The "File menu", "Edit 

"Window menu" & "Help menu".  There is also a "Tools menu" with additional options such 

as loading the "Windows" Calculator. 

When you access the "File" menu & choose "Close" your records are automatically saved, but 

you can always do a save, while you work, by clicking on the "Save" button with the green 

checkmark.  Also records are implicitly saved when you navigate from one record to another 

record.  "Note that a record is (one row)". 

The Main Program Menu consists of the following: 

A) Maintain Menu - For Master Records & Setup. 

B) Task Menu - For Transaction Records. 

C) Report Menu - To Print Various Reports. 

D) Option Menu - Here is where you can load theWindows Backup program to backup your 

files or perform other data tasks, such as importing and exporting.  We will explain more 

about this menu in the Options section. 

E) Window Menu - To switch to different Windows. 

F) Help Menu - Where you can access Help & Instructions. 
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5) Setting up Master records.  It is very important to setup your Master records before 

entering any Child Transaction records.  For example you must have a Child Master record 

particular child before you can enter Attendance for that Child.   Here is a list of the Master 

records that should be setup: 

A) Programs 

B) Charges 

C) Pay Types 

D) Staff Records 

E) Child Records 

F) Chart of Accounts 

Please review the "Setting Up Masters" section of the manual for important information on 

how too properly setup the Master records. 

6) Understanding How Things Work.   DayCare 2000/2005/2008 is designed specifically for 

customization.  This means that you can setup DayCare 2000 the way you do things.  For 

instance if you bill by the Day, then A Charge's frequency would be D for Daily, but if you 

bill by the Hour, then the frequency would be H for Hourly, W is for Weekly.  And you can 

do both.  You could have some Charge Types for Hourly, some for Daily, some for ½ Day, 

some for Weekly.  You'll learn more about this in setting up Master records. 

DayCare 2000/2005/2008 is designed to flow from section to section. 

A) Child Attendance Schedule to Child Attendance 

B) Child Attendance to Child Accounts 

C) OR Child Account Schedule to Child Accounts 

D) Staff Attendance from Child Attendance 

This is because Children's Attendance can be Recorded with the Staff assigned to that 

Activity or Program, Meaning Staff time is being recorded right along with Child times. 

E) Staff Payroll from Staff Attendance 

Even though we have setup DayCare 2000/2005/2008 to flow from section to section, you can 

it the way you want.  For example if you require parents to pay before the child can receive 

daycare, then you can go ahead & enter the receipt "& optionally the billing" at the same time 

.  Or if you prefer you can bill after the service "daycare" is provided & allow the parent to 

pay within a given time frame.  It's up to you.  In accounting terms, you handle your 

2000 books in cash or accrual.  Also we highly recommend using the Schedules  "Attendance 

Accounts" aka "Automate Attendance" or "Automate Accounts".  If you have children who 

your daycare on a regular basis, the Schedules can post that Child's Attendance & Account 

"Billing" information automatically.  You still have the option of editing the Schedule, 

Attendance or Account information at anytime.  Also if you wish not to use the Scheduler, 

because you prefer to enter Child Attendance or Account information as each day or week 

progresses, that's fine too.  Again it's up to you.  The main thing is to be consistent, so 
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that your records are consistent.  Also as far as billing goes, we have enabled an automatic 

Account Billing feature "in the Task/Post menu" that can automatically generate Child Billings 

, based upon Attendance.  It's your decision, if you wish to use it or not.  If you use this 

feature, then you will not need to use the "account schedule", because child accounts will be 

automatically generated from attendance.  One additional note, "that will be discussed again 

in setting up Programs, Charges and Child records", is that we give you the ability to tie 

each Charge automatically to a Program "customizable for each Child" & visa versa, you can 

tie each Program to a Charge. 

As you are entering child attendance "activities", DayCare 2000/2005/2008 will be 

automatically recording the staff person assigned to that child "in the Child Master record".  

This can be changed in the Attendance record at anytime.  If you use this feature, then you 

have the option of generating or posting Staff Time records to the Staff Time and Attendance 

records, from the Child records.  It's being done anyway in the background.  But if you 

prefer, you can use the Staff Attendance records directly & enter each staff person's time 

each day, along with there lunch.  Or you can do a combination.  You could post the Staff 

Time from the Children's Attendance records, & then edit them as needed.  And it goes 

further than that.  If you choose to use the Payroll component of DayCare 2000/2005/2008, 

then you can actually generate a Payroll from Staff Attendance. 

Another note about data input screens.  Many of these screens "or forms" will have "view 

located at the top right that allow you to view just certain records - such as a particular child 

, date or program.  Just  enter the view criteria "such as a date" & press enter.  Doing a right 

mouse on the field will reset the view to all records.  These "View or Filter" fields are great, 

because they help you view just the records you are interested in.  Many of these view fields 

will work together as well. 

Note:  DayCare 2000 uses "Tabs" on the main screen located at the bottom to access various 

features, where as DayCare 2005 & 2008 use buttons located at the top of the main screen. 

See Also:  Options & Tools. 
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SETTING UP MASTER RECORDS 

================================================== 

QUICK START NOTES: 

================================================== 

Setup each of the following by entering a unique id number and name or description and 

A) Programs 

B) Charges 

C) Pay Types 

D) Staff Records 

E) Child Records 

F) Chart Of Account Records 

================================================== 

DETAILED INFORMATION 

================================================== 

All Master Records can be accessed by clicking on "Maintain Masters" button located at the 

top of the main screen.  You can also access all Master records, by clicking on the Maintain 

Menu.  All of the Master records will be on this menu. 

A) Program Master Records - Programs are basically like classes.  They are the grade level or 

age group that a particular child is in.  Normally you would have the infants together, the 2 

-year-olds together etc...  Programs allow you to track these age groups together.  It's away 

of organizing your children.  If you prefer not to use Programs, then we recommend, just 

setting up one Program for all children.  You could call it "Daycare or Attendance". 

To add a new Program, click on the "Add New Record" button.  Each Program must have a 

unique id that is 3 digits or characters.  Numbers are preferred.   The Program fields include: 

1) Program Id - 3 digit unique number that identifies the Program. 

2) Name - The Program name. 

3) Age Group - The age group that will be in this Program. 

4) Ratio - How many children to a staff member. 

5) Status - A for Active & I for Inactive. 

6) Details - You can list any details here, such as courses 

or projects the class will work on. 

7) Charge Id - This is the default Charge code for this Program. 

Of course you may not have your Charges setup yet.  That's ok, you can add them later, after 

you have your Charges setup.  We have given Charges & Programs the ability to tie to each 

other.  This is customized on each child's card.  Each Charge will know what Program it's 

for & each Program will know it's associated Charges.  You can add as many Programs as 

like.  We suggest one for each age group.  Keep it simple so that's it's easy to manage.  You 
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can add additional Programs at anytime & you can delete or preferably inactivate Programs. 

B) Charge Master Records - Charges are the amounts you will be billing for providing daycare 

to your children.  You can Charge by the hour, ½ day, full day, weekly etc...  You can have 

multiple rates, for example you could have a discount rate for a 2nd child in the same family.  

You can have different Charge rates for different age groups.  You can also setup Charges for 

things like lunch, books & materials, registration & late fees.  When we get to the Child 

records, you will be able to setup the default Charge for each child.   

To add a new Charge, click on the "Add New Record" button.  Each Charge must have a 

id that is 2 digits or characters.  Numbers are preferred.   The Charge fields include: 

1) Charge Id - A 2 digit unique number to identify the Charge. 

2) Name - The name of the Charge. 

3) Frequency - How often this Charge occurs, such as weekly. 

H = Hourly 

D = Daily 

W = Weekly 

O = Other 

4) Amount - The amount of the Charge. 

5) Units - How many units this Charge will cover. 

6) Def Program - Is the default Program associated with this Charge.  You can use the 

pull down list above to select a Program.  If needed, this can be added later, after the 

Programs have all been setup.  

An additional note on the frequency & units.  You can really customize how you bill here.  

For example, maybe you have 3-day rate for children who come 3 days a week.  You could 

this in with a frequency of D for Daily, but then put the Units in at 3.  The Amount would be 

the daily charge, but when you enter a Charge for someone, it will automatically put 3 units 

in at the daily Charge to come out to the total 3-day Charge amount.  You can actually set it 

up in different ways, for example you could set it up with a frequency of W for weekly, with 

one Unit & the Amount of the Charge would be for the Total of 3 days.  So it's up to you to 

customize the Charges to meet your needs.  

C) Pay Types - You should have at least one Pay Type, such as "Regular". Pay Types are a 

of identifying those who have different pay sources or special pay qualifications such as a 

staff persons, who may receive a discount or someone who receives DFS money as a 

There are only 2 fields "Pay Id" & "Description".  Click on the "Add New Record" button to 

add a new Pay Type.  Enter a unique 2 digit number for the Pay Id field & then a Name or 

Description for the Pay Type.  When we get to the Child Master record, you will be able to 

assign each child a Pay Type, even if it's just Regular.  You can define the Pay Types any way 

that meets your needs.  One special note about the Pay Types, is that on the Child Master 
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record, you can put a percent.  The default is 100%, but you can use this to further customize 

Child Billings.  For example, if you have a parent that only pays part of a Child's Billing & 

DFS pays the other portion, then you can put the percent in that the parent pays.  When you 

add a Charge, it will automatically calculate the amount based on the percent.  If you do 

have outside sources, you may wish to use the Account Scheduler to handle automatic posting 

of these special Charges. 

D) Staff Master Records - You can use the Staff Master records for different or multiple 

purposes.  You can: 

A) Record Employment & Statistical Information 

B) Tie Child Attendance & Programs to Staff 

You will need to click on the "Add New Record" button to add a new Staff person.  You can 

the Staff records by "Individual Record" or by "List" or "spreadsheet style".  You will need to 

at least enter the required fields. 

The required fields include:  

1) Staff Id - A 5 digit unique id number. 

2) First - The staff's first name. 

3) Last - The staff's last name. 

4) Status - A for active & I for inactive 

The other Staff or Employee fields are optional, such as hire date & address & phone number.  

You can also assign each Child a default Staff person in the Child Master records. 

F) Child Master Records - Click on the first large button that says "Child" or from the 

"Maintain" menu choose  "Child", "Child".     The Child Master Record is the core of 

DayCare 2000/2005/2008.  With It You Can: 

1) Track Statistical Information for Each Child 

2) Assign a Child a Program(s) 

3) Assign a Child a Charge(s) 

4) Assign a Child a Pay Type 

5) Assign a Child Staff Person 

6) Record Family Information 

7) Record Medical Information 

8) Keep a Pickup List 

9) Record Child Notes 

10)  Record Child Immunizations 

11)  Keep a Waiting List 

There are many fields in the Child Master record.  Here are the required fields: 

1) Id No - Must be unique & 5 characters in length. 

2) First - The child's first name. 

3) Last - The child's last name. 
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4) Status - A = Active & I = Inactive. 

You should also assign each Child: 

1) A default Program 

2) A default Charge 

3) A Pay Type 

4) A Staff Person 

Note to add information for a new Child, you will need to click on the "Add New Record" 

button first.  Make sure each Child has a unique 5-digit number.  Note the "Sort" buttons at 

the top, which allows you to sort by Id No, Name or by Family Name, which is good if you 

have children from the same family. 

If you are going to track a Child's Programs, Activities & Attendance, then you will need to 

click on the "Charges & Programs" tab. Here you can enter: 

1) Program Id - The Programs "or class" this child is in.  Note, You must  

Use the special "Add" button to add a Program for a Child.  Also note that all of these items 

have pull down list for you to visually select the item you need, Instead of remembering an id 

number. 

2) Charge Id - Such as "Weekly or 2nd Child Rate".  This Charge will be tied to the Program 

in the same line.  You can add additional Programs and Charges for a Child.  The default 

Program & Charge is what will automatically be entered as you enter data for a child, but you 

will have the option to change this at anytime. 

3) Pay Id - Pay Type such as "Regular or DFS". 

4) Staff Id - The Staff person who normally works with this Child. 

Note: When entering Activities, Attendance & Child Account information, the Pay Id, Charge 

, Staff Id & Program Id will default to what ever has been entered in the Child Master record.  

The id number can be changed, but this makes it easier, by reducing data input later on. 

The other fields are optional & include: 

1) Child - Child statistics such as age & address. 

2) Parents - Parent or Guardian information. 

3) Contact & Medical - Emergency Contact & Medical information. 

4) Pickup List - Who can & can not pickup the child. 

5) Diet - The Child special diet needs. 

6) Notes - Additional information about the Child. 

7) List is a table view of the Child records. 

Shot records can be accessed from the Medical Page, by clicking on the top middle button.  It 

will have a speedtip that says "Shots & Immunizations".  The Waiting List can be accessed 

tab that says "List".  Click on the top middle button to access the Waiting List.    

You don't have to use all of the fields in the Child Master records, just the ones that apply to 

your daycare.  Also if you'll notice most screens for the Child Master record, have a "Print" 
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button.  These print buttons will print the associated report for that screen.  For example the 

Medical screen will print the Medical report, for the selected child or for all.  Of course all 

reports can be accessed from the Report menu as well. 

F) Chart of Account Records - From the "Maintain" menu choose "Chart of Accounts".     

Chart of account numbers can be used in paying bills, using payroll and using the checkbook.  

The chart of account numbers allows you to assign a gl code and description for a particular 

transaction.  Special Note that program codes are used as income codes.    Do not duplicate 

the program id numbers in the chart of accounts.  The chart of account code numbers should 

3 characters in length and should be unique numbers.  You can enter other income types in 

chart of accounts.  Normally accounting numbers would include 400-599 for income codes 

-799 for expense codes.  We suggest you follow these general accounting principals.  When 

entering bills or payroll, you can enter the gl code to tie that transaction to that particular 

gl code.  This will help your profit and loss statement to be organized.  For more information 

about using the chart of accounts contact your accountant or MapleSoft Enterprises. 

Master Reports Include: 

A) Program List, Program by Child, Program Groups & Labels 

B) Charge List 

C) Pay Types 

D) Staff List, Staff Time, Staff Analysis & Labels 

E) Child List 

F) Child Card 

G) Parent Report 

H) Pickup List 

I) Family Report 

J) Medical Report 

K) Diet Report 

L) Shots & Immunizations 

M) Waiting List 

N) Child Labels 

O) Chart of Accounts 

You can see more about these reports in the report section. 
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USING ATTENDANCE & ACTIVITY RECORDS 

================================================== 

QUICK START NOTES: 

================================================== 

1) Make sure Master Records are setup. 

2) Optionally:  Setup the "Attendance Schedule" - recommended. 

3) Optionally:  Use "Quick Attendance" on the main screen. 

4) Open Attendance Records from the main screen. 

A) View by individual    OR 

B) View all or by groups 

5) Add and edit attendance as needed. 

6) Print attendance reports from the report menu as needed. 

================================================== 

DETAILED INFORMATION 

================================================== 

Once you have your Master records setup, you can start entering Transactions.  Most daycare 

facilities record Attendance & Activities.    To access the Attendance records - Click on the 

large button on the main screen that says "Attendance" or click on the "Task" menu and 

"Attendance.    You will be asked, "View by individual child".  You have two ways of 

the Attendance records.  One is by Individual child, which means you view records for one 

child at a time, the other option will allow you to view & edit Attendance records for more 

than one child at a time.  This is a nice feature if you want to manage records for a group of 

children that are in the same Program.   

To add records for Attendance, click on the "Add new record" button.  You will notice that 

active child is available for recording Attenance.  When you add a new record, the "Time in 

Time out" should enter itself automatically accordingly to the defaults setup in your Company 

setup.  Of course you can change these times accordingly.  The date will be automatically 

with today's date.  Also the Program id, Staff id & Charge id will be automatically filled in 

according to that Child's Master record.  You can change any of the data & there is a note 

for additional information.  You'll also notice at the bottom a tab that says "Child List".  

This is so you can visually pick a child from the list without having to search.  Also even 

though a child has defaults for Programs, Staff & Charges, you can always use the pull down 

lists to quickly change that child to a different Program or Staff person.  Note, if you are not 

viewing the Attendance records "by individual accounts", then it will be necessary to enter the 

Child's id number or select it from the pull down list.   

Both individual & group layouts allow you to fill in the view criteria at the top to just view 

a certain child or location.  The group layout will allow you to view by Program id and date 
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as well.  After entering the Program id in the view filter, you can then set the date view, 

which will provide a combination criteria for the view to show just that Program id & date.  

A right mouse click on any of the view fields will reset the view to all.  To close & save 

your work, choose the "File menu" & choose "Close".  We recommend that you read the 

Scheduler aka Automate Attendance" section before actually entering Attendance and 

If you have children that come on a regular schedule, then the Scheduler can automatically 

enter their Attendance & Activity, which will save you time & data entry.  Each Program id 

each child is tied to that Child's default Charge id.  You can change this by clicking on the 

"Charge checkbox" which will display the Charge id.  This is optional, and is mainly if you 

are going to automatically generate Child Billings from Attendance records. 

On the main screen of DayCare 2000/2005/2008 is a checkbox that says "Quick Attendance".  

will open up a list on the main screen.  You can use this optional feature to automatically 

"Receive and Dismiss" children.  By double clicking on a child's name, you will 

record an attendance & Activity record for that child with his/her default information & the 

current time.  You probably won't want to use this feature if you are using the scheduler or 

use it for children that do not have a schedule. 

Attendance Reports Include: 

A) Attendance Report  "also by location" 

B) Program "By Child" 

C) Program "By Group" 

D) Who's Here 

You can see more about these reports in the report section. 

See Also:  Scheduling Attendance 
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USING THE CHILD ACCOUNTS 

================================================== 

QUICK START NOTES: 

================================================== 

1) Make sure Master Records are setup. 

2) Optionally:  Setup the "Account Schedule aka Automate Accounts" - recommended. 

OR 

3) Optionally:  Use "Auto Create Accounts" from the main screen. 

- also a recommended way of creating child account records. 

4) Open Account Records from the main screen. 

A) Use Quick Accounts "if you have a lot of children". 

5) Add and edit billings & receipts as needed. 

6) Print accounts reports from the report menu as needed. 

================================================== 

DETAILED INFORMATION 

================================================== 

Child Accounts is where you can maintain what each child owes your daycare.  To access the 

Child Accounts, click on the large button on the main screen that says "Accounts" or click on 

the "Task" menu & choose "Accounts".  At the bottom are two tabs.  The first one is the 

Account & the second one is the Child List, which is so you can quickly & visually find a 

child.  All account information is entered on the first page of "Child Accounts".   You can 

enter 3 types of transactions into a Child Account.  (1) A Bill or Invoice, (2) A Receipt & (3) 

A credit or adjustment to a bill or receipt.  To add a new transaction, click on the "Add New 

Record" button.  You will be asked is this is a Charge.  If you Answer "Yes or Ok", then a 

Charge will be added based on the Child's Master record.  All of the defaults, are always 

entered for you "Date, Pay Id, Charge Id & Units".  You can edit or change any of this 

information for Bills or Receipts.  Note that you can enter a Bill & Receipt at the same time 

as well.  The Account Fields Include: 

A) Reference Number - For Invoice or Check No. 

B) Date - Date of transaction. 

C) Pay Id 

D) Charge Id 

E) Units 

F) Charge Amount 

G) Receipt Amount 

H) Details 

I) Status 
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J) Notes 

After entering a Receipt, you may want to print out a Receipt for the person paying.  To do 

this, click on or select the row that has the receipt, then click on the 6th button, from the 

top left.  The speed tip will say "Print receipt".  Also, note the last button to the right 

will load the Windows Calculator.  If you need to change a Child's Pay or Charge id, then you 

can use the pulldown lists.  Each Charge id is tied to that Child's default Program id.  This 

allows you to print out the Income Analysis report that will list the income for each Program. 

You can view the Program id for a Charge by clicking on the Program id "checkbox" to 

it.  Also as you are entering Charges for a Charge, you can click on the "Calculate" button to 

Calculate the Charge for that Child.   You can also do an Alt + C with the keyboard to 

Calculate the Charge. 

Account Reports Include: 

A) Accounts Report 

1) Each individual or All 

2) By Location 

3) Summary or Detailed 

4) Current Month Only 

B) Accounts Due Report 

C) Income Analysis Report 

D) Receipt Slip 

E) Statement 

You can see more about these reports in the report section. 

See Also:  Scheduling Accounts 

See Also:  Options - for Auto Creating Accounts 
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AUTOMATING OR SCHEDULING ATTENDANCE OR ACCOUNTS 

================================================== 

QUICK START NOTES: 

================================================== 

1) Make sure Master Records are setup. 

Attendance 

2) Setup daily schedule for each child.  Day = 1-5 

3) Enter starting date in (top right) "day 1" field "once for all". 

4) Post by clicking on "post" button "once for all". 

Accounts 

2) Setup daily schedule for each child. 

3) Enter Starting reference no in "top right" field "once for all". 

4) Enter Starting date in "top right" field "once for all". 

5) Post by clicking on "post" button "once for all". 

================================================== 

DETAILED INFORMATION 

================================================== 

With the Attendance Scheduler you can automatically Schedule your Child  Attendance and 

Activities.  This is a Weekly Schedule.  To access the Schedule, click on the large button on 

the main screen that says "Attendance Schedule or Automate Attendance" or click on the 

menu" & choose "Schedule".  Each child will have an individual Schedule.  You can quickly 

a child by using the tab at the bottom that says "Child List".  Once you have chosen a child, 

click on the tab that says "Child Schedules".  When you click on the "Add new record" button 

for a child, his default information will be entered into the Schedule "Program Id, Staff Id 

etc.".  The "Time in & Time out" will be automatically entered based on the defaults in your 

Company setup.  Of course all of these fields can be changed by you, if this child has 

different information other than his Child Master record or the Company defaults.  Each day 

should have a 1, 2, 3, 4 or 5 which determines the day of the week.  Also note that by 

entering a 0 "zero" for a particular day will stop that day from being posted, which works 

good for holidays.   Also after you have entered everyone's Schedule, you should enter the 

"global starting date" at the top which sets the starting date for everyone at one time.  

After all of the Schedules are entered and the Starting date is entered, then you can click on 

the top last button to post all Schedules to Attendance at one time.  You should only do this 

once, "And Not for each child", because the Post button will post all of the Child Schedules 

at one time.  Also you should only do this once a week, since it is a Weekly Schedule.  Once 

the Schedule has been posted, you can still return to the Attendance records and edit the 

records that have been posted if needed.  Before you post the records each week, it will be 
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necessary to reset the Starting date in the Schedule so that the new postings will have the 

new dates for the week.  You can change, edit or add to the Schedule at anytime.  If you 

have children that come at the same times each week, we recommend you save yourself time 

by using the Schedule.   The Scheduler looks & works like the Attendance records.  We 

recommend reading the Attendance section as well, which describes more about fields and 

what to enter. 

With the Account Scheduler you can Schedule to Bill Children automatically each week.  The 

Account Scheduler works just like the Account records themselves, only you will enter 

for just the number of days you wish to bill for. You can access the Account scheduler from 

the main screen by clicking on the "Account Scheduler" button or by choosing it from the 

Menu".    If a child only comes in 3 days a week, then you would enter 3 records, one for 

day.  If a child comes in every day, then you would enter 5 records.  Or if you Charge by the 

week or by the day, you can enter one record per week with 5 units or 3 units if it is a 3-day 

child.  It's up to you how you want the Charges to list out.  This should conform to how you 

setup your Master Charge records.  You will want to post the Scheduler only once a week.  If 

you do it twice, you will double your records, which means you will have to edit your Account 

records, to remove the extra records.  Each time before posting the Schedule, you will want to 

use the entry fields at the top of the Scheduler form to set the "Dates" of the Schedule and 

the "Reference number".   The button at the top right with the "green checkmark" is the 

button.  This will actually Post or create the New Billings in Accounts.  Only do this once 

per week, or you will have double billings.  This will post all the child records at one time  

- you won't do it for each child individually.  Special note:  You may not want to use the 

account scheduler.  You may prefer to use the "Automatic Account Generator or Creator" 

can automatically create child account billings directly from attendance.  Both the scheduler 

or generator will save you time.  We recommand using on or the other - "You can't use both". 

Schedule Reports Include: 

A) Attendance Schedule 

B) Account Schedule 

You can see more about these reports in the report section. 

See Also:  Using Attendance 

See Also:  Using Accounts 

See Also:  Options & Tools 
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USING THE CHECKBOOK 

================================================== 

QUICK START NOTES: 

================================================== 

1) Open Checkbook from the "Checkbook & Financials" button on main screen. 

2) Add new checks & receipts using the "Add New Record" button. 

3) Fill in fields - Amounts, Date, gl code  etc... 

4) Calculate balances. 

5) Save 

6) Note:  Receipts from child accounts can be posted as deposits and bills and payroll can be 

posted as checks or disbursements. 

================================================== 

DETAILED INFORMATION 

================================================== 

With the Checkbook you can record all of your Checks and Deposits.  You can also reconcile 

to your bank statement.  You can access the Checkbook from the "Task" menu or by clicking 

on "Checkbook & Financials" button located at the bottom of the main screen.  As you record 

Receipts from Child Accounts, you have the option of posting them to the Checkbook.  And 

you record Bills or Payroll checks you have the option of posting them to the Checkbook.  

The Checkbook has the following fields: 

A) Ref or Check No 

B) Date 

C) Name  

D) Amount 

E) Balance "This is calculated for you" 

F) Status "X = Check is in bank statement" 

G) Details 

H) Code "Such as a G/L number" 

We suggest you record each transaction with a Code.  The Code should be consistent to the 

type of entry.  For example if you are paying the phone bill, you might always want to use 

601 and if you are paying the gas bill you might always want to use 602.  As you post 

Account Receipts to the Checkbook, the Charge code will automatically be entered as the code 

, but you can change this if you like.  We suggest that you record Deposits "income" with the 

Charge code or a 400 through 499 code.   

We recommend you record Checks "expenses" with a Charge codes of 600 through 699.  This 

keep in line with standard accounting principals.  Keep it simple, but organized.  Your 

accountant will appreciate the organization of income and expenses.  You don't have to code 
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any entries, but it will help organize things for you.  Also the "Profit & Loss" report uses 

these codes to organize income & expenses on the report. 

As you make entries into the Checkbook, positive amounts should be deposits & negative 

amounts should be checks.  To calculate the balance, click on the "Calc Bal" button.  Also 

you might find it handy to use the Windows Calculator.  You can access it from top tool 

bar.  You can post the following items from the Main Menu "Task & Post" Menu.  Choose 

Post from the "Task" Menu & then choose:  

A) Child "Receipts to checkbook" 

B) Bills to checkbook "Checks" 

C) Payroll to checkbook "Checks" 

This will update the Checkbook with entries from these other components.  Note that if you 

are using "Bills or Payroll", you will want to keep these posted after running batch checks.  

Both of these get their next available check number from the Checkbook. 

Checkbook Reports Include: 

A) Checkbook Details Report 

B) Checkbook Codes Report 

C) Reconciliation 

D) Profit & Loss Report "From Receipts & Checks". 

You can see more about these reports in the report section. 

See Also:  Paying Bills 

See Also:  Options & Tools. 
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PAYING BILLS 

================================================== 

QUICK START NOTES: 

================================================== 

1) Start up Pay Bills from the "Checkbook & Financials" button on main screen. 

2) Add new bills using the "Add New Record" button. 

3) Fill in fields - Amounts, Date etc... 

4) Save 

5) Print Checks if desired. 

6) Post to the checkbook. 

================================================== 

DETAILED INFORMATION 

================================================== 

Paying Bills allows you to record all of your expense and to write checks.  Paying Bills can 

be accessed from the "Task" menu or by clicking on "Checkbook & Financials" button located 

the top of the main screen.  You can Pay Bills anytime you.  To pay a bill, click on the "Add 

New Record " button.  The bill has the following fields: 

A) Check No 

B) Date 

C) Code 

D) Check Amount 

E) Payee and address of payee 

F) Any details or notes 

You don't have to print checks, but the option is available.  If you wish to automatically 

update the check number(s) for a particular date, then you can click on the small "Wrench" 

button, located next to the check number field.  This button will examine the Checkbook for 

next available number and then fill in the check number field for any checks for the date your 

are working on.  All of your bills will remain here for viewing or editing, unless you put them 

into History.  You can print a check by clicking on the "Print" button.  You can "Batch" print 

group of checks or bills, by clicking on the "Batch Print" button.  All checks for current 

record's date will be printed, if you choose the Batch print. 

If you wish to look at previous Bills "besides using the navigation button", you can click on 

the tab at the bottom "Expense List".  Here you can scroll through all of your Bills.  You can 

also use the view criteria fields located at the top to set the view to just one date or just 

one Company or Payee.  To reset the view to all, just do a right mouse click on one of the 

view fields.  If you are setting the view to a particular Payee, a lot of times, you can 

just enter a partial name.  For example for "ABC Phone Co", you could probably just enter 
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"ABC".  You can also use the "Search" button to search for a Payee.  You can Post Bills to 

the Checkbook from the "Main menu", choosing "Tasks" & then choose "Post" & then choose 

"Bills".  This will keep your Checkbook up to date.  Do this anytime you need the 

updated or when you pay Bills.   

Bill & Expense Reports Include: 

A) The Check 

B) Bills Report "All or by location". 

You can see more about these reports in the report section. 

Also See:  Using the Checkbook. 

Also See:  Options and Tools. 
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MENU PLANNER 

================================================== 

================================================== 

INFORMATION 

================================================== 

You can access the Weekly Menu Planner from the "Task Menu".  Here you can enter any or 

information for the Week's "Meals" Menu.  You can enter the items that will be available & 

even their costs if needed.  You can print the Weekly Menu Planner Report by clicking on the 

Report button located at the top.  With the Planner, you do not add new records, you simply 

change the existing records for the new week. 

Menu Planner Reports Include: 

A) Weekly Menu Planner Report 

You can see more about these reports in the report section. 
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SHOTS & IMMUNIZATIONS 

================================================== 

================================================== 

INFORMATION 

================================================== 

You can record each Child's Shot and Immunization records.  These records can be accessed 

created by clicking the "Maintain Menu, Choose  Child & then Shots".  You can also access 

these records, from within the Child Master records, by going to the Medical page "there is a 

button at the top that will open these records". To add a new Shot record: 

A) Locate the Child by using the navigation buttons or use the Find button. 

B) Click on the "Add New Record" button. 

C) Fill in the appropriate information: 

A) Shot Name 

B) No Required & Received 

C) Last Date Received & Next Date Due 

D) Status "O for Open or C for Closed" 

You can enter as many Shots for each Child as needed.  You will also need to edit or update 

these records as children receive expected immunizations.  You can print the Shot Report by 

clicking on the "Print" button located at the top.  This report will tell you what Shots have 

been given & what Shots are due.  You can use the "shots pull down list" to have shot name 

inserted for you.  You can also "build your own list" - use the "shots button" to build this 

list. 

Shot Reports Include: 

A) Shots 

You can see more about these reports in the report section. 
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WAITING LIST 

================================================== 

================================================== 

INFORMATION 

================================================== 

You can maintain a Child Waiting List for children you are expecting to come into your 

facility in a future date.  You can access the Waiting List by: Clicking on the "Maintain" 

, choose child & then "Waiting List".  You can also access this list from the Child Master 

records, by going to the Child List section & then click on the Waiting List button.  In the 

Child Waiting List you can record: 

A) Child Name 

B) Date of Application 

C) Expected Arrival Date 

D) Status A or I "Active or Inactive" 

E) Any additional Notes 

You can also automatically add or activate a child into the Child Master records, by selecting 

that child in the list & then click on the Activate  "light bulb" button.  This will add the 

selected child to the Child Master records assigning him or her to the next available number. 

Waiting List Reports Include: 

A) Waiting List Report 

You can see more about these reports in the report section. 
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REPORTS 

================================================== 

QUICK START NOTES: 

================================================== 

Access all reports from main menu by choosing "Reports".  Many reports can be printed from 

within data screens as well.  Such as printing receipts from within child accounts or checks 

from within bills.  

================================================== 

DETAILED INFORMATION 

================================================== 

Reports can be accessed from the Main Report Menu.  Also each form where you enter data 

records, will have a "Print" button that will print the report associated with those records.  

Many reports give you the option of printing a Date Range, so that you select the records you 

want on that report.  Also many reports allow you to narrow this selection farther by allowing 

you to print all on a selected id such as Child id, Program id or Staff id.  Reports can be 

printed to screen or the printer.  MapleSoft DayCare Reports Include: 

Master Reports Include: 

======================== 

A) Program List, Program by Child, Program Groups & Labels 

B) Charge List 

C) Pay Types 

D) Staff List & Labels 

E) Child List 

F) Child Card 

G) Parent Report 

H) Pickup List 

I) Family Report 

J) Medical Report 

K) Diet Report 

L) Shots & Immunizations 

M) Waiting List 

N) Child Labels 

O) Chart of Accounts 

Many of these reports give you the option of printing all children or you can select an 

individual child by using the pull down selection list. 

Attendance Reports Include: 

======================== 
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A) Attendance Report ** 

B) Program "By Child" * 

C) Program "By Group" *** 

D) Who's Here 

* This report give you the option of printing all children or you can select an individual child 

by using the pull down selection list. 

** Allows you to enter any date range, so that you can look at the report for any period, such 

as for a week or a month or even a year. 

*** This reports give you the option of printing all programs or you can select an individual 

program by using the pull down selection list. 

Account Reports Include: 

======================== 

A) Accounts Report * 

1) Each individual or All 

2) By Location 

3) Summary or Detailed 

4) Current Month Only 

B) Accounts Due Report ** 

C) Receipt Slip 

D) Statement "with option to email as text file attachment". 

In order to print a receipt slip, you must be in the Account records and your cursor must be on 

the row that contains the receipt.  Then just click on the print button. 

* This report give you the option of printing all children or you can select an individual child 

by using the pull down selection list. 

** Allows you to enter any date range, so that you can look at the report for any period, such 

as for a week or a month or even a year.  Access this report from the "Report/Finincial" 

Schedule Reports Include: 

======================== 

A) Activity Schedule * 

B) Account Schedule * 

* This report give you the option of printing all children or you can select an individual child 

by using the pull down selection list. 

Checkbook Reports Include: 

======================== 

A) Checkbook Details Report ** 

B) Checkbook Codes Report ** 

C) Reconciliation 
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D) Profit & Loss Report "From Receipts & Checks". ** 

** Allows you to enter any date range, so that you can look at the report for any period, such 

as for a week or a month or even a year. 

Bill & Expense Reports Include: 

================================================== 

A) The Check 

B) Bills Report ** 

In order to print a check, you must be in "Pay Bills".  Select the record or check no to print 

and then click on the Print button.  Use the Batch Printing button for printing more than one 

check with the same date. 

** Allows you to enter any date range, so that you can look at the report for any period, such 

as for a week or a month or even a year. 

Staff Reports Include: 

======================== 

A) Labels 

B) Staff List or Detail 

Menu Planner Reports Include: 

=========================== 

A) Weekly Menu Planner Report 

To print the Weekly Menu Planner "for meals", open the Weekly Planner from the Task Menu 

& click on the Print button. 

Shot Reports Include: 

======================== 

A) Shots * 

* This report give you the option of printing all children or you can select an individual child 

by using the pull down selection list. 

Waiting List Reports Include: 

======================== 

A) Waiting List Report 

Financial Reports Include: 

======================== 

A) Profit & Loss 

B) Bills or Expense 

C) Checkbook "see above" 

================================================== 
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OPTIONS & TOOLS 

================================================== 

================================================== 

INFORMATION 

================================================== 

Other Settings can be accessed from "Company Setup".  Here you can: 

1) Setup passwords 

2) Insert Account Ref No:  Automatically inserts the next ref no. 

================================================== 

Task/Post Menu 

1) Post Receipts * - to the Checkbook 

2) Post Bills * - to the Checkbook 

3) Post or Generate Child Account Billings * From Child Attendance Records to Child 

Account Records 

================================================== 

Options Menu 

1) Copy Attendance:  You can copy one day's Attendance to another day & then edit the 

records. 

2) Windows Calculator:  Can be accessed from many forms as well, such as the Checkbook. 

3) Service Databases:  This will clean up your data records.  We recommend this once a 

or if you are having trouble with data files. 

4) Windows Backup:  This will load the Windows Backup program or you can access it from 

the Windows "Accessories/System" menu.  If the Windows Backup program is not installed, 

can install if from the "Control Panel/Add Remove Software" section.  You'll probably need 

your CD, when installing.  You should backup all files ending in the exenstions (dbf, dbt & 

mdx) in the dc2000 directory. 

5) Putting Data into History "Archiving":  This will put data "through a specific date" into 

history or archive files.  These records will be removed from your normal records & will be 

placed into the history records.  We recommend doing a backup before placing anything into 

history.  Also you will not want to put open items into history, such as child account bills not 

yet paid or the child account will require editing or adjusting. 

================================================== 



 

44MAPLESOFT DAYCARE MANUAL Page: 

Title 

Options & Tools 

Details 

OTHER INFORMATION 

================================================== 

Support:  If you are having trouble, need assistance or training, you can contact MapleSoft 

Enterprises at: 

Web: www.maplesoft.net 

E-Mail: support@maplesoft.net  

Phone: (573) 339-1514 

Mail: P.O. Box 121 

Gordonville, MO 63752 

Email will get you the fastest support response. 

================================================== 

The below (About Time) information does not apply to DayCare 2008 2nd Edition, because 

have upgraded and fixed the (time bug) in this new edition. 

About Time:  DayCare 2000/2005/2008 allows you to enter time in either standard time "2:30 

or in military time "14.50".  This is chosen in the company setup section.  If you are using 

standard time, you will need to enter an "A or P" for AM/PM or actually "Morning & 

Afternoon/Evening", in time fields such as child attendance or staff attendance.  If you are 

using hundredths/military time, you can use the "Time Help" button that will display on forms 

that require time entries.  The minutes for total time displayed is always displayed in 

hundredths, this is because even if you enter data in standard time, DayCare 2000/2005/2008 

will convert the time to a numeric that can have time math performed on it.  If you enter total 

time, such as in payroll, the minutes need to be in hundredths.  For example "2 hours & 30 

minutes = 2.5" or 8 hours & 45 minutes = 8.75 or "6 hours & 15 minutes = 6.25.  This is so 

calculations will return the correct answer.   8.3 times an hourly rate will not pay an 

for 8 & ½ hours, you must enter 8.5.  If you are creating payroll records from staff attendance 

records, this will not be a concern, because the program will calculate the correct time for you. 

But if you enter total hours your self, you must enter it correctly as described here. 

Note: There is a small bug in DayCare 2000/2005/2008 when regarding recording times. 

recording morning time - enter an A. When entering an afternoon or evening time enter a P. In 

DayCare 2000/2005/2008 Morning = 1:00 AM to 12:59 Noon. And afternoon = 1:00 pm to  

12:59 midnight. If you are recording your time in hundredths or military time, this is not an 

issue. 

It only becomes an issue if you are recording times manually, in which case you need to 

the above guidelines for the A & P times and then the program will report time totals 

================================================== 

Minimum System Requirements: 

IBM PC/Compatible  
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Windows 2000 or greater  

Pentium III 

512 Meg Ram  

10 Megs available on Hard drive  

Optionally: Mouse  

Most Printers Supported 

Recommended System Requirements: 

IBM PC/Compatible  

Windows XP or greater  

Pentium 4 or greater 

1 Gig Ram or greater 

25 Megs available on Hard drive  

Mouse  

================================================== 


